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REPORTING REQUIREMENTS

The Department is afforded authority by Section 324.0221(1)(a) (Florida Motor Vehicle No-Fault Law),
Florida Statutes, to develop procedures, rules and regulations to create and maintain an automobile

insurance reporting database (insurance file).

The purpose of this manual is to set forth the procedures to accommodate insurance company reporting

and department processing of reported data.

Section 324.0221(1) (a), Florida Statutes, reads in part:

“Each insurer that has issued a policy providing personal injury protection coverage or property
damage liability coverage shall report the cancellation or nonrenewal thereof to the department
within 10 days after the processing date or effective date of each cancellation or nonrenewal. Upon
the issuance of a policy providing personal injury protection coverage or property damage liability
coverage to a named insured not previously insured by the insurer during that calendar year, the
insurer shall report the issuance of the new policy to the department within 10 days. The report
shall be in the form and format and contain any information required by the department and must
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be provided in a format that is compatible with the data processing capabilities of the department.
Failure by an insurer to file proper reports with the department as required by this subsection
constitutes a violation of the Florida Insurance Code. These records shall be used by the
department only for enforcement and regulatory purposes, including the generation by the
department of data regarding compliance by owners of motor vehicles with the requirements for
financial responsibility coverage.”

DAILY REPORTING
INTRODUCTION

The following are the specifications for insurance companies to use to report records as defined by the
Department of Highway Safety and Motor Vehicles (DHSMV or “the Department”). This manual is
predominantly specific to the XML coding. In the future, the latest version of the XML schema and XSD
files will be located on our FR Website, http://www.flhsmv.gov/FRManualFTP/.

The XML schema is what you will use to create your files that you send us. There is a schema version
number located in the XML file; the file that you send to us must include that same schema version
number in order for your file to be processed.

The XSD file is used for validation. There are a number of free tools on the Internet that use this file to
validate the XML file that you created. If a modification must be made to the XML schema, the insurance
companies will be notified by the Department at least 90 days in advance. IMPORTANT: All files
must be encrypted using DHSMV’s public key before being placed on the SFTP site;
otherwise, the file will not be picked up. Also, the maximum number of records in a daily
file should not exceed 100,000. This number is calculated by counting the number of
times the <transaction>tag is used. If <transaction>is used more than 100,000 times in
a daily file, a ValidationFailed file will be placed in the Output folder.

Florida Motor Vehicle No-Fault Law FTP Reporting Procedures

PGP Keys

The insurance company must generate two keys. A private key used to decrypt files, and a
public key which the Department will use to encrypt files. You may use your existing keys;
otherwise, please contact the Department for needed information about exchanging keys and
encrypting files. IMPORTANT: The files uploaded to the server must be encrypted using
DHSMV’s public key; otherwise, the files will not be processed.

Logging into the SFTP Server
Once the PGP keys have been exchanged, an encrypted file will be sent to the insurance
company containing user name and password information.
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Sending and Receiving Files

The encrypted files must be placed on the new server, which uses SFTP protocol and port 22.
The server name is: FTPCEREX.flhsmv.gov. The new server will behave the same as the old
FTP server, so the passwords and PGP keys will remain the same. The usernames will have
one small change, which is a zero (‘0’) was added to the beginning of the username. For
example, if your original username was ‘9332FTP’, it will now be ‘09332FTP’.

File Specifications

The file name may be called whatever makes sense to the insurance company. After the file is
processed, it is placed in the Archive folder. The transfer results will be placed in the Output
folder.

Transaction Types

The basic purpose of the insurance file is to determine the presence or absence of coverage and the
status (issued or cancelled) based on the related information sent by the insurance company.
Transactions without errors will be recorded on the insurance file and those with content errors will be
returned to the filing company to be corrected within 30 days. Transaction types developed for the
purpose of formatting and recording the insurance file information are:

10  Cancellation/Non-Renewal

11 Recall of Cancellation

12 SR21 Verification Responses

13 Vebhicle totaled or sold

20  Initiation of Insurance

21  Recall of Issuance of Coverage

22 SR22 Certificate of Liability Coverage
26  Certificate of Cancellation (of SR22)

30 Change Effective Date, Level of Coverage or Policy Holder Address
31  Add Vehicle to Policy

32  Delete Vehicle from Policy

33 Non-Cancelable PIP

34  Add Driver/Policy Holder to Policy

35 Delete Driver/Policy Holder from Policy

36 Cancellation of Non-Cancelable PIP
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44  FR44 Certificate of Higher Limits Liability Coverage

46  FR46 Certification of Cancellation (of FR44)

Information indexes are used to match or identify a vehicle and a policy holder on the file. These
indexes are driver licenses and VIN numbers which are collected from information in the Department’s
driver license, vehicle registration and insurance files.

Financial responsibility cases resulting in notices are “generated”, “not generated” or “cleared” based
on information contained in the insurance file using the mentioned indexes.

Different transaction types for the same policy can be submitted in the same transaction and/or file and
will be processed in the order received. The transactions must be submitted in logical order to avoid
any unnecessary errors. Below are a few examples:

1. If a Cancellation (10) and a Recall of Cancellation (11) is submitted for the same policy in the
same file, but the Recall of Cancellation is listed first, an error will be returned because the
Cancellation was not processed yet.

2. |If thereis currently one vehicle on a policy and an Add Vehicle (31) and a Delete Vehicle (32) are
submitted for the same policy in the same transaction, but the Delete Vehicle is listed first, an
error will be returned because the only vehicle on the policy will be removed. In order to
replace a vehicle, an Add Vehicle must be submitted before the Delete Vehicle. The same logic
applies to Add Driver (34) and Delete Driver (35).

3. Inorder update a driver’s name, an Add Driver (34) must be listed first with the updated name
and then a Delete Driver (35) with the original name can follow.

New Fields for XML File

Level of Coverage

The ‘Level of Coverage’ field is a new, optional field used to describe the level of coverage contained on
a vehicle in a policy. Annually, the department sends close to one million suspension notices to
customers for the purpose of verifying insurance. Sixty percent of our case types (this means some
event occurred) require the customer to provide us the levels of insurance to ensure they meet Financial
Responsibility requirements. Reporting this threshold in advance, would eliminate a SR-21 verification,
prevent customer calls to your company, and provide better overall customer service to our mutual
customers.

Vehicles registered as ‘Commercial Motor Vehicles’ as described in s. 320.01(26), are required to have
certain levels of coverage as described in section 627.7415 and these levels must be verified by Florida
Driver License/Tax Collector Offices at time of registration, per statute. Currently, our mutual customers
provide this information via a paper document (COl). If these levels were reported through the
insurance database, it would eliminate the need for manual verification and allow these customers to
utilize on-line services thus freeing up the lines in offices across the state. This level of coverage should
have a corresponding value (shown below) of ‘01’ thru ‘08’.
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Field Value

Definition

01

PIP/PDL 627-7275 324.0221 324.0222
Minimum coverage is $10,000 personal injury protection (PIP) and $10,000 property
damage liability (PDL)

02

BI/PDL 10/20/10 Basic Bl 324.021

Minimum limits of bodily injury liability of $10,000 per person, $20,000 per crash,
$10,000 property damage liability per crash, and PIP limits of $10,000 per person per
crash

03

BIL/PDL 100/300/50 DUI 324.023

Minimum limits of bodily injury liability of $100,000 per person, $300,000 per crash,
$50,000 property damage liability per crash, and PIP limits of $10,000 per person per
crash

04

BIL/PDL Commercial 627.7415 50 CSL (in addition to 10k PIP)
Minimum limits of Bodily Injury Liability and S 50,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Vehicles > 26k Ibs)

05

BIL/PDL Commercial 627.7415 100 CSL (in addition to 10k PIP)
Minimum limits of Bodily Injury Liability and $100,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Vehicles > 35k Ibs)

06

BIL/PDL Commercial 627.7415 300 CSL (in addition to 10k PIP)
Minimum limits of Bodily Injury Liability and $300,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Vehicles > 44k Ibs)

07

BIL/PDL Commercial 627.7415 750 CSL (in addition to 10k PIP)
minimum limits of Bodily Injury Liability and $750,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Hazardous Materials)

08

Taxi BIL/PDL - 125/250/50 324.032/627.7415

minimum limits of bodily injury liability of $125,000 per person, $250,000 per crash,
$50,000 property damage liability per crash, and PIP limits of $10,000 per person per
crash (For Taxi Cabs)

Policy Through Date

The Policy Through Date field is a new, optional field used to describe the expiration date of the policy.
In the future, this field will be used to identify when a policy is no longer valid. At this time, a
transaction type ‘10’ cancellation of insurance (or non-renewal) will still need to be reported to our
department, and must be used for a type ‘10” transfer. Until further notice, the through date is not
being used but is there for future functionality. Again, if you decide to use the through date, once the
through date is reached and you are not sending a renewal, you must send a cancellation (transaction

type ‘10°).

Insurance Company Notes

The Insurance Company Notes field is a new, optional field used to by the insurance companies. This
field will be returned with error files.
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Policyholder Date of Birth

The Policy Holder Date of Birth field is a new, optional field. If your customer does not have a Florida
Driver License Number, the Policy Holder Date of Birth is one of three fields (along with Name and
Policyholder Gender) that are required to generate a driver’s license number.

Policyholder Gender

The Policy Holder Gender field is a new, optional field. If your customer does not have a Florida Driver
License Number, the Policy Holder Gender is one of three fields (along with Name and Policyholder Date
of Birth) that are required to generate a driver’s license number.

Effective Date of the Policy Holder

The Effective Date of the Policy Holder field is a new, optional field used to describe the date the
driver/policy holder was added to the policy. In a reload file, the PH Effective Date is optional (if a ‘34’ is
not used) and will be defaulted to the Policy Effective Date if left blank. However, during a Daily Load,
the Policy Holder Effective Date for a ‘34’ transaction type will be required.

Effective Date of the Vehicle

The Effective Date of the Vehicle field is a new, optional field used to describe the date the car was
added to the policy. In a reload file, the Vehicle Effective Date is optional (if a ‘31" is not used) and will
be defaulted to the Policy Effective Date if left blank. However, during a Daily Load, the Vehicle Effective
Date for a ‘31’ transaction type will be required.
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Filing Record Layout

ltem No | Node or | Field Name Character type Required Length | Comments
Element Optional
Conditional
1 N Insurance Company R Unbounded
la E FL Company Code Numeric R 5
2 N Transaction R Unbounded
2a E Transaction Type Numeric R 2
3 N Policy R Unbounded
3a E Insurance Policy Number Alphanum R 30
3b E Policy Effective Date Date R 8 MMDDCCYY
3c E Policy Through Date Date C 8 MMDDCCYY
3d E Insurance Company Notes | Alphanum 0] 50
4 N Policy Holder R Unbounded
4a E Company Indicator Alpha R 1 YorN
4b E PH First Name Alpha C 16
4c E PH Middle Name Alpha 0] 16
4d E PH Last Name Alpha C 20
de E PH Name Suffix Alpha 0] 3
4f E PH Gender Alpha 0] 1 M or F or Blank
4g E PH DOB Date 0] 8 MMDDCCYY
4h E PH Street Address Alphanum 0] 30
4i E PH City Alpha 0] 20
4j E PH State Alpha 0] 2
4k E PH Zip Numeric 0] 9
41 E FL DL Number Alphanum 0] 13
4dm E FEID Numeric 0 9
4n E PH Non-Structured name | Alphanum C 50
40 E PH Transaction Type Numeric C 2
4p E Effective date of the PH Date C 8 MMDDCCYY
4q E FR Case Number Alphanum C 9
4r E FR Certification Date Date C 8 MMDDCCYY
4s E FR Prepared Date Date C 8 MMDDCCYY
5 N Vehicle C Unbounded
5a E Fleet Indicator Alpha R 1 YorN
5b E VIN Alphanum C 21
5c E Vehicle Year Numeric C 4 CCYY
5d E Make Alphanum C 5
Se E Effective date of the Date 0] 8 MMDDCCYY
vehicle
5f E Level of Coverage Numeric ] 2 01-08
5g E Vehicle Transaction Type Numeric C 2
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6 N Verifications (o Unbounded
6a E Tracking Number Provided by C 36
HSMV
(Alphanum)
6b E Required Coverage Date Provided by C 8 MMDDCCYY
HSMV (Date)
6¢C E Status Message Provided by C 50
HSMV
(Alphanum)
6d E Days Late Provided by C 3 le. 040
HSMV (Numeric)
6e E Yes Confirmed and Active | Alpha C 1 YorN
6f E Confirmed Alpha C 1 YorN
6g E Unconfirmed Alpha C 1 YorN

Conditional Field Applicability:

Transaction Type (2a): Any transaction type can be used here. For transaction types: 10, 11, 13, 21, 22,
26, 33, 36, 44 and 46, no other transaction types can be performed within the same transaction. For
transaction types 20, 30, 31, 32, 34 and 35, you can include other transaction types within the same

transaction.

PH Last Name (4d): If Company Indicator = ‘N’, then the PH’s last name is required. A hard error
message will be received, if the Last Name is missing.

FEID (4m): If Company Indicator = Y’, then the FEID is optional. A warning message will be received, if
the FEID is missing.

PH Non-Structured Name (4n): If Company Indicator = ‘Y’, then the PH Non-Structured Name is

required. A hard error message will be received, if the PH Non-Structured Name is missing.

PH Transaction Type (40): For a Daily submission, there are two possible scenarios:

1. When submitting an initiation, a ‘20’ needs to be in position 2a and a ‘34’ will need to be in
position 4o0. This is used to show a driver/PH has not been on the policy since the policy
effective date.

2. A ‘34’ can bein position 2a if there is already an initiation (type 20’ transaction) with the same
policy number on the database or in the same file.

Note: The below applies for both policy holders and vehicles.
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e |n a Daily file, if you are reporting the policy for the first time AND you have multiple
policy holders AND the policy holder effective date is the same as the policy effective
date then all information will be under the ‘20’ in position 2a.

e In a Daily file, if you are reporting the policy for the first time you have multiple policy
holders AND the policy holder effective date is different than the policy effective date
then a 20’ will be in position 2a and a ‘34’ with the policy holder effective date will be
needed for any policy holder with a different effective date

e In a Daily file, if you are NOT reporting the policy for the first time AND you have one or
multiple policy holders AND the policy holder effective date is the same for all policy
holders then all information will be under the ‘34’ in position 2a and you can fill out the
effective date in position 3b.

e In a Dailyfile, if you are NOT reporting the policy for the first time AND you have one or
multiple policy holders AND the policy holder effective dates are different from each
other then all information will be under the ‘34’ in position 2a and you can fill out the
policy holder effective date in position 4p for each policy holder

Effective Date of PH (4p): When using a transaction type ‘34’ in position 4p, the Effective Date of the
Policy Holder is required when performing a daily update to add an additional policyholder to a policy

that we already have on file. Note, if the ‘34’ is in position 2a, then you will use position 3b for the
effective date.

FR Case Number (4q): For transaction types: 22, 26, 33, 36, 44 and 46 when submitting SR-22s and FR-
44s. The FR Case Number must be present for 12 type Verification Requests from HSMV.

FR Certification Date (4r): For transaction types: 22, 26, 33, 36, 44 and 46 when submitting SR-22s and
FR-44s. The Certification Date should be the date that the particular transaction type was certified.

FR Prepared Date (4s): For transaction types: 22, 26, 33, 36, 44 and 46 when submitting SR-22s and FR-
44s. The Prepared Date should be the date that the specific transaction type is prepared.

VIN (5b): If Fleet Indicator = ‘N’, then the VIN is required. A hard error message will be received if the
VIN is missing.

Vehicle Year (5c): If a VIN is present, then the Vehicle Year is required. A hard error message will be
received if the Vehicle Year is missing.

Make (5d): If a VIN is present, then the Make is required. A hard error message will be received if the
Make is missing.

Vehicle Effective Date (5e): When using a transaction type ‘31’ in position 5g, the Effective Date of the
Vehicle is required when performing a daily update to add an additional vehicle to a policy that we

already have on file. Note, if the ‘31’ is in position 2a, then you will use position 3b for the effective
date.

Vehicle Transaction Type (5g): For a Daily submission, there are two possible scenarios:
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1. For submitting an initiation, a ‘20’ needs to be in position 2a and a ‘31’ will need to be in
position 5g. This is used to show a vehicle has not been on the policy since the policy effective
date.

2. A ‘31’ can be in position 2a if there is already an initiation (type ‘20’ transaction) with the same
policy number on the database or in the same file.

Note: Transaction type (2a) should never be left blank.

Tracking Number (6a): Only used for Verification requests, transaction type ‘12’. When a transaction

type 12 (SR21 verification request) is sent to your insurance company, it will contain a tracking
number. The tracking number should not be altered. This will allow other information to be changed,
i.e., policy number, company code, etc.

Required Coverage Date (6b): Only used for Verification requests, transaction type ‘12’. When a
transaction type 12 (SR21 verification request) is sent to your insurance company, it will contain the

required coverage date. The required coverage date should not be altered.

Status Message (6c): Only used for Verification requests, transaction type ‘12’. When a transaction type
12 (SR21 verification request) is sent to your insurance company, it will contain a specific status
message, which will be provided in the near future. The status message should not be altered.

Days Late (6d): Only used for Verification requests, transaction type ‘12’. When a transaction type 12
(SR21 verification request) is sent to your insurance company, you have 30 days to respond. If after 30
days we have not received a response, we will continue to resend the SR-21 every 30 days. In the Days
Late field, you will be provided with the number of days that have passed since the original date that the
SR21 was sent.

Confirmed and Active (6e): Only used for Verification requests, transaction type ‘12’. When set to ‘Y’,
this means that the driver had coverage with your insurance company on the SR21 Required Coverage

Date and is still active today. This record will be treated as a ‘20’ type transaction.

Confirmed (6f): Only used for Verification requests, transaction type ‘12’. When set to ‘Y’, this means
that the driver/vehicle did have coverage with you on the SR21 Required Coverage Date.

Unconfirmed (6g): Only used for Verification requests, transaction type ‘12’. When set to ‘Y’, this
means that the driver did not have coverage with you on the SR21 Required Coverage Date or that you
are unable to confirm. The customer will receive a pending suspension letter.

NOTE: When responding, each policy holder must have only one (6e, 6f, 6g) set to ‘Y’ and the others
set to ‘N’.
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Additional Information:

Multiple Company Codes

For each file, companies can submit multiple FL Company codes as you have done in the past. For each
FL Company code that is identified, companies can submit multiple transactions. For each transaction,
companies can submit the policy information. Within the policy node, companies can include all policy
holders and vehicles associated with policy.

Out of State Driver’s License Numbers

If the driver’s license is out of state or country, please leave the Driver’s License field blank, so you will
not receive any errors. If you do have a Florida’s Driver’s License, please provide us with the
information.

Accepted Special Characters
There are a few errors that reference “invalid characters”. The acceptable special characters are a space,
a hyphen (-) or an apostrophe ().

Adding Drivers and Vehicles

The following is an example of when a ‘31’ can be used in a reload :

Say for instance you have a policy that has been in effect since 10/01/2011 with only one vehicle on that
policy. Then in February, a second vehicle is added to the policy. If you wanted to show that the new
car has not been on that policy since the policy effective date, you would use a ‘31’ transaction type. A
20’ would be in position 2a and then in the vehicle section, you would have the original vehicle listed.

In order to report the new vehicle, you would have a second vehicle section with a transaction type ‘31’
in position 5g with the second vehicle effective date (5e).

For a Daily submission, you can submit your Add and Deletes individually or you can have multiple
transactions. If you are submitting them individually, you will use transaction type (2a). If you are
adding a vehicle and driver, you would put a ‘34’ in the transaction type (2a) and a ‘31’ in the Vehicle
Transaction Type (5g). Or if you wanted to only add a driver to an existing policy, you would put a ‘34’ in
the Transaction Type (2a) field.

IMPORTANT: Transaction Type (2a) should never be left blank.

Empty XML Fields

In XML, an empty element or an empty space may be submitted. Please see example below.
For example, if the policy does not have an FEID number, any of the following will work:

<FEID/> OR

Page | 15



<FEID></FEID> OR

<FEID> </FEID>
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Transaction Processing
Error codes are referenced in the transaction details below. The error code list is located on page 23.
NOTE: Transaction Type (2a) should never be left blank.

Transaction 20: Initiation of Insurance
Transaction 20 is used to create the insurance record when filing a policy insurance, initiation or policy
origination.

When filing a transaction 20 for fleet coverage policies, vehicle information is optional for all
transactions. Fleet policies are defined as those policies insuring more than twenty-five (25) vehicles.
The fleet indicator field is in the Vehicle entity on the XML schema.

This transaction should not be used to reinstate a policy that has been cancelled and reinstated under
the same policy number. In order to reinstate a cancelled policy, submit a Recall of Cancellation (11).

If the policy already exists in the insurance database, the transaction will be returned, in the error file,
with an error (047).

The required fields for a ‘20’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
e (1a) COMPANY CODE
e (2a) TRANSACTION TYPE
e (3a) POLICY NUMBER
e (3b) EFFECTIVE DATE OF POLICY
o (4a) COMPANY INDICATOR
o (4b & 4d OR 4n) PH NAME OR COMPANY NAME
e (5a) FLEET INDICATOR

e (5b) VIN
e (5c) Vehicle Year
e (5d) Make

*note: renewals should be sent as a transaction 30.

Transaction 21: Recall of Initiation

Transaction 21, along with all other transactions covered below, are updates or changes to the
transaction 20 initiation. This transaction is filed only in the case of a transaction 20, policy initiation,
being filed in error. Examples of conditions that can cause a policy to be filed in error is the transmission
of an initiation, transaction 20, before the underwriter reviews and declines the insurance based on the
past driving history of the intended insured.

If a Recall of Initiation (21) is submitted, but an Initiation of Insurance (20) does not exist on the
insurance database, the transaction will be returned, in the error file, with an error (050).
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If a Recall of Initiation (21) is submitted and the policy is currently in a cancelled status, the transaction
will be returned, in the error file, with an error (031).

If a Recall of Initiation (21) is submitted 90 days after the effective date of the policy, the transaction will
be returned, in the error file, with an error (032).

The required fields for a ‘21’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
 (1a) COMPANY CODE

(2a) TRANSACTION TYPE

(3a) POLICY NUMBER

(3b) EFFECTIVE DATE OF THE RECALL OF INITIAITION

Transaction 10: Cancel/Non-Renew Policy/Expired

Transaction 10 is used when cancelling or non-renewing an initial policy (transaction 20). It should
never be used to delete a vehicle or a driver from an existing multiple vehicle or driver policy on the file
because it results in a cancellation of the entire policy.

If a Cancellation is submitted for the policy that is not on the Insurance database, the transaction will be
returned with an error (050)

If the policy is currently cancelled on the database but another transaction 10 is sent with a different
cancellation date, the cancellation date will be updated and the transaction will be returned, in the error
file, with a warning (051).

The effective date of the cancellation (“Policy Through Date”), (3c), must be equal to or greater than the
effective date filed with the transaction 20; when this occurs, the status of the policy will be changed to
‘cancelled’.

If the effective date of the cancellation is earlier than the effective date of the policy, the policy will
remain active and will be returned, in the error file, with an error (013).

The required fields for a ‘10’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:

(1a) COMPANY CODE

(2a) TRANSACTION TYPE

(3a) POLICY NUMBER

(3¢) EFFECTIVE DATE OF CANCELLATION
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Transaction 11: Recall of Cancellation
Transaction 11 is used when the filing company recognizes that a cancellation (10) has been filed in
error or that the policy has been reinstated.

If a Recall of Cancellation is submitted for the policy that is not on the Insurance database, the
transactions will be returned, in the error file, with an error (050).

If the policy is not in a cancelled status already, the transaction will be returned, in the error file, with an
error (022)

The effective date of the recall transaction must be equal to or greater than the cancellation date filed
with the transaction 10, when this occurs the status of the policy will be changed to ‘active’.

If the effective date of the recall is less than the cancellation date, the policy will remain cancelled and
will be returned, in the error file, with an error (026).

The required fields for an ‘11’ transaction are listed below and correspond to the Filing Record Layout on

page 8.
REQUIRED:
e (1la) COMPANY CODE
e (2a) TRANSACTION TYPE
e (3a) POLICY NUMBER
e (3b) EFFECTIVE DATE OF RECALL OF CANCELLATION

Transaction 13: Sold/Totaled Vehicles
Transaction 13 is used when a vehicle filed with the policy initiation transaction has been reported sold
by the insured or determined to be a total loss by the insuring company due to an accident.

If the policy does not exist in the database, the transaction will be returned, in the error file, with an
error (050).

If the vehicle reported sold/totaled is the only vehicle on the policy, the status of the policy will be
changed to ‘Cancelled’.

If there are other vehicles on the policy besides the vehicle being reported sold/totaled, only the vehicle
being reported will be removed and the policy will remain ‘active’.

The required fields for a ‘13’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
e (1a
e (2a
e (3a
e (3b

COMPANY CODE

TRANSACTION TYPE

POLICY NUMBER

EFFECTIVE DATE OF THE SOLD/TOTALED

~ — — —
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e (5b) VIN
e (5c) Vehicle Year
e (5d) Make

Transaction 30: Change Effective Date and Address

Transaction 30 is used to modify an existing policy in the DHSMV database. The policy number must
exist in the insurance database and be in an ‘active’ status. If the policy does not exist in the database,
the transaction will be returned, in the error file, with an error (050). If the policy is not in an active
status, the transaction will be returned, in the error file, with an error (011).

The transaction type 30 is used to:

1. Change of policy effective date (ex: renewal of a policy)
2. Change a policy holder’s address
3. Change the Level of Coverage for a vehicle

If a change to the policy holder’s address is desired, then the Driver’s name on the filing must be the
same as the original filing driver’s name. If the driver’'s names do no match, the transaction will be
returned, in the error file, with an error (048).

If a renewal is desired, then the effective date of the update (3b) should be the date of the renewal. If a
change to the policy holder’s address, policy holder’s name or level of coverage is desired, then the
effective date of the update (3b) should be the same as the original filing policy effective date. If the
effective date of the update (3b) is not the same as the original filing policy date when changing the
policy holder’s address, policy holder’s name or level of coverage, the update will change the initiation
date of the policy to the effective date of the update.

NOTE: If you use Transaction 30 for any other reason than a renewal, the effective date required will
update the policy issue date.

NOTE: Due to the ability of having multiple drivers on a policy, in order to perform a name change or
driver’s license change, an Add Driver (34) must be submitted first with the updated name and then the
Delete Driver (35) with the original name can follow in a new transaction. For both transactions, the ‘34’
and ‘35’ will be in position 2a.

The required fields for a ‘30" transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
« (1a) COMPANY CODE
e (2a) TRANSACTION TYPE
e (3a) POLICY NUMBER
e (3b) EFFECTIVE DATE OF THE UPDATE
e (4a) COMPANY INDICATOR
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e (4b & 4d OR 4n) PH NAME OR COMPANY NAME (only applicable if updating a PH address)
e (4h, 4i, 4j, 4k) ADDRESS (only applicable if updating a PH address)

e (5b) VIN (only applicable if updating the level of coverage)

e (5f) LEVEL OF COVERAGE (only applicable if updating the level of coverage)

Transaction 31: Add Vehicle
Transaction 31 is used when a newly acquired or replacement vehicle is added to a previously filed
initiation policy, or a vehicle that was not sent with the original policy transmission.

The effective policy date required in the filing record should be the date the vehicle was added to the
policy and not the original effective date of the policy unless the vehicle was on the policy from
origination but was not filed with the origination. This transaction should only be used to add a vehicle
to a policy that has been successfully filed on the insurance file.

If the policy does not exist in the database, the transaction will be returned, in the error file, with an
error (050).

If the policy is not in an active status, the transaction will be returned, in the error file, with an error
(011).

If the VIN submitted already exists on the policy, the transaction will be returned, in the error file, with
an error (034). If the add date or any other vehicle information needs to be modified, then a 32 (Delete
Vehicle) should be submitted, followed by a transaction 31 (Add Vehicle) with the updated information.

If the VIN submitted is present on two or more active policies for the same insurance company, the
transaction will be returned, in the error file, with an error (043).

The required fields for a ‘31’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
e (1a) COMPANY CODE

e (2a) TRANSACTION TYPE or (5g) VEHICLE TRANSACTION TYPE (Use 5g, if more than one
transaction type is occurring on the record (ie. adding a vehicle and driver))

e (3a) POLICY NUMBER

e (3b) EFFECTIVE DATE OF ADDING VEHICLE

e 5a) FLEET INDICATOR

e (5b)VIN

e (5c) Vehicle Year

e (5d) Make
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Transaction 32: Delete Vehicle

Transaction 32 is used when the company or the insured elects to delete, drop or eliminate a vehicle(s)
from a policy. When a transaction 32 is received and the vehicle VIN number is located on the insurance
file with the existing policy number, the vehicle is deleted.

If the policy does not exist in the database, the transaction will be returned, in the error file, with an
error (050).

If the policy is not in an active status, the transaction will be returned, in the error file, with an error
(011).

If the VIN submitted does not exist on the policy, the transaction will be returned, in the error file, with
an error (044).

The required fields for a ‘32’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
e (1a) COMPANY CODE
(2a) TRANSACTION TYPE or (5g) VEHICLE TRANSACTION TYPE (Use 5g, if more than one
transaction type is occurring on the record (ie. adding a vehicle and driver))
(3a) POLICY NUMBER
(3b) EFFECTIVE DATE OF REMOVING VEHICLE
(5b) VIN

Transaction 34: Add Driver/Policy Holder
Transaction 34 is used when a new driver is added to a previously filed initiation policy, or a driver that
was not sent with the original policy transmission.

The effective policy date required in the filing record should be the date the driver was added to the
policy and not the original effective date of the policy unless the driver was on the policy from
origination but was not filed with the origination. This transaction should only be used to add a driver to
a policy that has been successfully filed on the insurance file.

If the policy does not exist in the database, the transaction will be returned, in the error file, with an
error (050).

If the policy is not in an active status, the transaction will be returned, in the error file, with an error
(011).

If the provided Driver’s License number cannot be verified, the transaction will be returned, in the error
file, with an error (OOL).
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If the driver’s license number submitted already exists on the policy, the transaction will be returned, in
the error file, with an error (046). If the add date or any other driver information needs to be modified,
then a 35 (Delete Driver) should be submitted, followed by a transaction 34 (Add Driver) with the
updated information.

The required fields for a ‘34’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:
e (la) COMPANY CODE
(2a) TRANSACTION TYPE or (4p) PH TRANSACTION TYPE (Use (4p), if more than one transaction
type is occurring on the record (i.e., deleting a vehicle and driver))
(3a) POLICY NUMBER
(3b) EFFECTIVE DATE OF PH ADDED or (40) Effective Date of PH if (4p) was used above.
(4b & 4d OR 4n) PH NAME OR COMPANY NAME

Transaction 35: Delete Driver/Policy Holder

Transaction 35 is used when the company or the insured elects to delete, drop or eliminate a driver(s)
from a policy. When a transaction 35 is received and the driver’s license number is located on the
insurance file with the existing policy number, the driver is deleted.

If removing a driver who was originally submitted without a driver’s license number is desired, then the
Driver’s name on the filing must be the same as the original filing driver’s name. If the driver’s names do
not match and the DLN field is blank, the transaction will be returned, in the error file, with an error
(048).

If the policy does not exist in the database, the transaction will be returned, in the error file, with an
error (050).

If the policy is not in an active status, the transaction will be returned, in the error file, with an error
(011).

If the driver’s license number submitted does not exist on the policy, the transaction will be returned, in
the error file, with an error (045).

If there is only one driver on the policy, the driver cannot be deleted. The transaction will be returned,
in the error file, with an error. A transaction 34 (Add Driver) must be submitted prior to the transaction
35 (Delete Driver).

The required fields for a ‘35’ transaction are listed below and correspond to the Filing Record Layout on
page 8.

REQUIRED:

e (la) COMPANY CODE
e (2a) TRANSACTION TYPE or (5g) VEHICLE TRANSACTION TYPE (Use 5g, if more than one
transaction type is occurring on the record (i.e. deleting a vehicle and driver))
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o (3a) POLICY NUMBER

e (3b) EFFECTIVE DATE OF PH Removed or (5e) Effective Date of PH if (5g) was used above.

e (4b & 4d) PH NAME OR COMPANY NAME (only applicable if deleting a driver with no DLN on
record)

Transaction 12: Verifications

The 12 transactions generated by DHSMV are used to verify SR21 reported policy information.
Insurance Companies must verify if the customer had the appropriate insurance on the requested need
date. Appropriate insurance is identified by the Level of Coverage in the request. Please see below:

If Level of Coverage (5f) is a ‘01, confirm that the vehicle(s) present (5b) or if none present, that
the individual (4b-e) has a minimum coverage of PIP/PDL (Minimum coverage is $10,000
personal injury protection (PIP) and $10,000 property damage liability (PDL) ).

If Level of Coverage (5f) is a ‘02’, confirm that the vehicle(s) present (5b) or if none present, that
the individual (4b-e) has a minimum coverage of BI/PDL 10/20/10 (Minimum limits of bodily
injury liability of $10,000 per person, $20,000 per crash, $10,000 property damage liability per
crash, and PIP limits of $10,000 per person per crash).

If Level of Coverage (5f) is a ‘03’, confirm that the vehicle(s) present (5b) or if none present, that
the individual (4b-e) has a minimum coverage for a DUI of BIL/PDL 100/300/50 (Minimum limits
of bodily injury liability of $100,000 per person, $300,000 per crash, $50,000 property damage
liability per crash, and PIP limits of $10,000 per person per crash).

When verification is sent to the insurance company, all fields that we have data for will be populated.
When submitting a transaction type 12, each of the following fields must have a value of either ‘Y’ or ‘N’:
(6e) CONFIRMED AND ACTIVE, (6g) CONFIRMED and (6h) UNCONFIRMED. Please do not modify any of
the supplied data.

When a verification is returned and CONFIRMED AND ACTIVE = ‘Y’ but the policy does not exist on the
DHSMV database, an error message will be returned (TBD)

NOTE: If the date is in the future this will be the customer’s suspension date if they do not acquire
insurance prior to that date. Insurance companies can confirm on current date.

Transaction 22: SR22 Bodily Injury Liability/Property Damage Liability/Personal Injury
Protection

The 22 transactions are used for the insurance company to report SR22 certificate of liability coverage
(BIL limits of at least 10/20/10). These are only needed if a customer did not have the required liability
coverage at the time of an event, (crash, point’s suspension, habitual offender suspension, DUI’s
convictions on or prior to October 1, 2007 or other non-alcoholic convictions).

Page | 24



REQUIRED:

¢ (la) COMPANY CODE

e (2a) TRANSACTION TYPE

¢ (3a) POLICY NUMBER

e (41)DLN

e (4r) SR/FR CERTIFICATION DATE
e (4s) SR/FR PREPARED DATE

Transaction 26: SR26 Cancellation of Bodily Injury/ Property Damage Liability /Personal
Injury Protection

The 26 transactions are used for the insurance company to report an SR26 Certificate of Cancellation of
an SR22.

REQUIRED:

 (1a) COMPANY CODE

e (2a) TRANSACTION TYPE

e (3a) POLICY NUMBER

o (41)DLN

e (4r) SR/FR CERTIFICATION DATE
e (4s) SR/FR PREPARED DATE

Transaction 33: SR22 PIP Non-Cancellable 6 Month

The 33 transactions are used for the insurance company to report a Non CancellableSR22 Certificate of
Personal Injury Protection/Property Damage Liability. These are only needed if a customer was
convicted of a No Proof of Insurance charge and subsequently unable to show proof of the minimum
state required coverage at the time of the offense.

REQUIRED:

e (1a) COMPANY CODE

e (2a) TRANSACTION TYPE

e (3a) POLICY NUMBER

e (41)DLN

e (4r) SR/FR CERTIFICATION DATE
e (4s) SR/FR PREPARED DATE

Transaction 36: Cancellation of SR22 PIP Non-Cancellable 6 Month

The 36 transactions are used for the insurance company to report a Certificate of Cancellation of an
SR22 non-Cancelable 6-month policy. A 36 transaction type will only be accepted if the Cancellation
Date is within one month of the issued effective date, or the cancellation is being reported due to a
suspended DLN.
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REQUIRED:

¢ (la) COMPANY CODE

e (2a) TRANSACTION TYPE

¢ (3a) POLICY NUMBER

e (41)DLN

e (4r) SR/FR CERTIFICATION DATE
e (4s) SR/FR PREPARED DATE

Transaction 44: Non-Cancellable 6 Month - Bodily Injury Liability/Property Damage
Liability /Personal Injury Protection

The 44 transactions are used for the insurance company to report FR44 Non-Cancellable Certificate of
Liability Coverage (BIL limits of 100/300/50). The FR44s are reported if a customer had a DUI conviction
after October 1, 2007, but did not have the required BIL/PDL coverage 100/300/50 at the time of the
offense.

REQUIRED:

e (1a) COMPANY CODE

o (2a) TRANSACTION TYPE

« (3a) POLICY NUMBER

e (41)DLN

o (4r) SR/FR CERTIFICATION DATE
o (4s) SR/FR PREPARED DATE

Transaction 46: Bodily Injury Liability/Property Damage Liability/Personal Injury
Protection

The 46 transactions are used for the insurance company to report an FR46 Certificate of Cancellation of
an FR44. A 46 transaction type will only be accepted if the Cancellation Date is within one month of the
issued effective date, or the cancellation is being reported due to a suspended DLN.

REQUIRED:
e (1a) COMPANY CODE
e (2a) TRANSACTION TYPE
e (3a) POLICY NUMBER
o (41)DLN
o (4r) SR/FR CERTIFICATION DATE
e (4s) SR/FR PREPARED DATE
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Error Message Information

XSD Validation

Prior to processing the file, we validate that the XML schema is correct. If there is an issue with
the schema, a text file will be generated and placed in the Output folder. The file name will
follow the following structure: ValidationFailed_Timestamp.pgp

Transaction Errors

An output file will be generated and placed in the Output folder for the insurance companies,
regardless if any errors occurred. If no errors occurred, there will be a count of the number of
records imported into the database. If there were errors because of data within the file is not
formatted correctly, only the records with errors will appear in the transaction report. Records
without any errors will be imported into the database. Once those records have been corrected,
by the insurance company, they can be resubmitted in a Daily Reporting file. The reload file will
NOT need to be re-submitted. An output file will be generated and placed in the Output folder
for the insurance companies. The transaction report name will follow the following structure:
YourFileName_TimeStamp_DL_TransactionReport.pgp

Transaction Error Codes and Error Messages:

Below are the transaction error codes and error messages. In parenthesis, is information regarding if
the record will still be imported when the error is received.

e 001 — VIN not registered with FL DHSMV. HSMV will attempt to validate the VIN, as
registered, again in 30 days (will import)

e 002 — Partial 15-digit match on VIN (will import)

e 003 — Unable to locate single VIN match; multiple partial matches found (will not import)

e 004 - VIN is not valid (will not import)

e 005 - VIN must be 17 characters for a vehicle year greater than 1980 (will not import)

e 006 — VIN is required for non-fleet policies (will not import)

e 007 — Company code is not registered with FL DHSMV (will not import)

e 008 — Company code must be 5 digits (will not import)

¢ 009 — Transaction type is not valid for reloads, transaction type must be set to 20, ‘31’
or ‘34’ (will not import)

e 010 - Reload policy is cancelled on database (will not import)

e 011 - Policy is currently cancelled (will not import)

o 012 - Vehicle Effective Date is required on '31' transaction types (will not import)

e 013 - Policy Through/Cancellation Date cannot be prior to Policy Effective Date (will not
import)

¢ 014 — Through Date must be a valid date (MMDDCCYY) (will not import)

e 015 - Found active policy on the database with an Effective Date after the submitted
effective date (will import)

e 017 — Level of Coverage is not in the correct format (will not import)

e 018 — VIN contains invalid characters (will not import)
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¢ 019 — Policyholder first name contains invalid characters (will not import)

e 020 — Active policy not found on reload (will not import)

e 021 — Policy is currently cancelled and needs to be recalled (will not import)

e 022 - Cannot recall cancelation, policy is currently active (will not import)

¢ 023 — Policyholder last name contains invalid characters (will not import)

e 024 — Vehicle Effective Date cannot be in the future (will not import)

¢ 025 — Vehicle Effective Date must be a valid date (MMDDCCYY) (will not import)

o 026 - Recall of cancellation date cannot be prior to the cancellation date (will not import)

e 027 — 30 Day Notice: Second attempt to validate the VIN, as registered, has not been
successful (will not import)

o 028 — Last attempt to validate the VIN, as registered, was unsuccessful; the record will
be removed from our database. Please verify the VIN and resubmit the updated
information through a Daily Reporting (will not import)

e 029 — Policy number contains invalid characters (will not import)

e 030 - On areload, cannot submit a transaction type '31" without submitting a '20" (will
not import)

e 031 - Cannot recall initiation of insurance, policy is currently cancelled (will not import)

e 032 —The recall of initiation date is 90 days after the policy effective date (will not
import)

¢ 033 —On an Initiation at least one vehicle is required (will not import)

e 034 — Vehicle already exists on policy (will not import)

e 036 — On a reload, cannot submit a transaction type '34' without submitting a '20" (will
not import)

o 037 — Policyholder Effective Date must be a valid date (MMDDCCYY) (will not import)

e 038 — Policyholder Effective Date is required on '34' transaction types (will not import)

e 039 — Policyholder effective date cannot be in the future (will not import)

¢ 040 — Company indicator is invalid, please choose 'C' or leave blank (will not import)

e 041 - Fleet indicator is invalid, please choose 'F' or leave blank (will not import)

e 042 — Vehicle Make is required (will not import)

e 043 - Vehicle exists on multiple active policies (will not import)

o 044 — Vehicle does not exist on the policy (will not import)

e 045 - Driver does not exist on the policy (will not import)

e 046 — Driver already exists on the policy (will not import)

o 047 — Policy already exists in our database (will not import)

e 048 — Cannot update policy, Driver's name does not match (will not import)

e 049 — Cannot add driver or vehicle, initiation record had an error (will not import)

e 050 — Initiation of Insurance is not present (will not import)

e 051 — Cancellation updated, policy was already cancelled (will import)

e 052 — Invalid Transaction Type (will not import)

e 053 — Cancellation processed. Driver’s license number supplied was invalid (will import)

e 054 — Cannot delete driver from the policy, only one driver currently exists (will not
import)
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e 056 — VIN does not exist on the policy (will not import)

e 057 — VIN is required when updating the Level of Coverage (will not import)

e 059 — SR22 not required, no open FR Suspensions exist for the DLN provided (will not
import)

e 060 — Certification Date must be a valid date (MMDDCCYY) (will not import)

e 061 - Prepared Date must be a valid date (MMDDCCYY) (will not import)

e 062 — Duplicate SR22/26 or SR33/36 or FR44/46 found (will not import)

e 063 — Case is older than 3 years, a SR/FR Certificate is no longer needed (will not
import)

e 064 — A newer SR/FR Certificate has been found (will not import)

e 065 — No matching SR/FR Certificate could be found when attempting to process the
cancellation (will not import)

e 066 — Level of Coverage insufficient, must have at least a '04' Level of Coverage (will not
import)

e 067 — Level of Coverage insufficient, must have at least a '05' Level of Coverage (will not
import)

e 068 — Level of Coverage insufficient, must have at least a '06' Level of Coverage (will not
import)

e 069 — Level of Coverage insufficient, Level of Coverage must be set to '08' (will not
import)

e 070- Multiple Offender - Not sent to insurance company (will import; in house only)

e 071 —When responding to verifications, the values for ' CONFIRMED AND ACTIVE',
'CONFIRMED' or 'UNCONFIRMED' must be set to either "Y' or 'N' (will not import)

o 072 —When responding to verifications, only one of these fields can be set to 'Y’, the
others need to be set to ‘N': 'CONFIRMED AND ACTIVE', 'CONFIRMED' or
'UNCONFIRMED' (will not import)

e 073 — Currently, we are not accepting this transaction type in XML format. Please
resubmit this transaction in a 350-character flat file (will not import)

e 074 — Confirmed flag must be a Y or N (will not import)

e 075 — Verification Not Requested or Already Received (will not import)

e (076 — Cancellation Date cannot be more than 45 days in the future for a Commercial
policy (will not import)

e 077 — Cancellation Date cannot be in the future for a Non-Commercial policy (will not
import)

e (078 - Effective Date Cannot be prior to current effective date (will not import)

e 049 — Cannot add driver or vehicle, initiation record had an error (will not import)

e 00A — Transaction Type contains invalid characters (will not import)

e 00B — Policyholder middle name contains invalid characters (will not import)

e 00C - Vehicle Year not a valid year (will not import)

e 00D - Vehicle Year required when VIN is present (will not import)

e 0O0E - Insurance policy number required (will not import)

e OOF - Policyholder first name missing (will import)

e 00G - Policyholder last name required (will not import)
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e 0O0H - Policyholder state not valid (will not import)

e 00l — Policyholder zip code not valid (will not import)

e 00J - Policyholder zip code not complete (will import)

e 00K — Florida Driver’s License is not in the correct format (will not import DLN, but will
import the record)

e 00L — No matching FL DLN found (will not import DLN, but will import the record)

e 0O0OM — DLN is not required on Fleet policy (will import)

e 0ON — Current Driver's License Number Found - (will import)

e 000 — Company FEID is missing (will import)

e 00P — Company FEID must be 9 digits (will import)

e 00Q — No matching FEID number found (will import)

e 0O0OR — Company name is missing (will not import)

e 00S — Company indicator is invalid, please choose ‘Y’ or ‘N’ (will not import)

e 00T - Effective Date must be a valid date (MMDDCCYY) (will not import)

e 00U — Effective Date cannot be in the future (will not import)

e 00V - DOB is not a valid date (MMDDCCYY) (will not import)

e 00W — DOB cannot be in the future (will not import)

e 00X — Gender must be ‘M’ or ‘F’ or blank (will not import)

o 00Z - Fleet Indicator is invalid, please choose Y’ or ‘N’ (will not import)

Holding Errors

This is new functionality that applies to the XML format only. When a VIN is submitted through
a Reload or Daily Reporting file and cannot be located in the HSMV database. The system will
import the record into the Insurance Database and place the VIN in the ‘Holding’ location. The
insurance company will receive a warning message that will be placed in their Output folder on
the server. The VIN will be checked again in 30 days to see if it has been registered with the
DHSMV. If the VIN is still not registered, we will send another file with a warning natification to
the Output folder informing you that the system tried to verify the VIN again and was
unsuccessful. The VIN will remain in the holding location and will be flagged to be checked
again in another 30 days. If the VIN has still not been registered after 60 days, we will send the
final file with an error message to the Output folder notifying you that the final attempt to verify
the VIN was unsuccessful and the record is going to be removed from our database. The
insurance company should verify the VIN with the policy holder and resubmit any changes you
make to the record. At any time, during the three checks, if the VIN is verified, the record will be
imported and you do not have to resubmit. The file name will be for these errors will be
Unregistered_Vins_timestamp_DL_TransactionReport.xml.

Also, when we receive a valid Cancellation (type 10) or a valid Recall of Initiation (type 21), we
will update the database and put the vehicle information in the Holding table to be checked 20
days later. We are checking to ensure the vehicle is insured. The insurance companies will not
need to perform any action after submitting the cancellation.
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Steps to validate a XML file (Reload or Daily) against the XSD file:

First, you will need an XML tool. The free tool we use here is Notepad ++. You can download it
at: http://notepad-plus-plus.org/ . Once installed, on the file menu, go to ‘Plugins’ > ‘Plugin
Manager’ > ‘Show Plugin Manager’ and install ‘XML Tools’.

1. Download the following file from http://www.flhsmv.gov/FRManualFTP/
: ‘FLBOB_Template_Reload_and_Daily_Inputs.xsd’. Or if you are having issues
downloading the file, please request it to be emailed to you by contacting
FLHSMVInsuranceliaison@flhsmv.gov

2. Open the XML tool, if you are using Notepad ++, on the File menu, go to ‘Plugins’ >
‘XML Tools’ > ‘Validate Now’. Browse to the location of the
‘FLBOB_Template_Reload_and_Daily Inputs.xsd’ file.

3. Click “OK” to validate.

You will either receive an “INFORMATION” window with your errors or a message stating your

file validated successfully. If you have errors, correct the errors and then re-validate your
file. Repeat until you receive the successful validation message.
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